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To the Reader  
 
Welcome to the medical and electrical engineering world of g.tec! 
Discover the only professional biomedical signal processing platform under MATLAB and Simulink. Your 
ingenuity finds the appropriate tools in the g.tec elements and systems. 
Flexibly choose and combine the elements for biosignal amplification, signal processing and stimulation 
to perform even real-time feedback. 
 
Our team is prepared to find the best solution for your needs. 

Take advantage of our experience! 
 
Dr. Christoph Guger Dr. Guenter Edlinger 
 
 
Researcher and Developer 
 
Reduce development time for sophisticated real-time applications from month to hours. 
Integrate g.tec's open platform seamlessly into your processing system. 
g.tec's rapid prototyping environment encourages your creativity. 
 
Scientist 
 
Open new research fields with amazing feedback experiments. 
Process your EEG/ECG/EMG/EOG data with g.tec's biosignal analyzing tools. 
Concentrate on your core problems by relying on g.tec's new software features to handle ICA, AAR or 
online Hjorth's source derivation. 
 
Study design and data analysis 
 
Are you planning an experimental study in the field of brain or life sciences? We can offer consultation in 
experimental planning, hardware and software selection and can even do the measurements for you. If 
you have already collected EEG/ECG/EMG/EOG, g.tec can analyze the data starting from artifact control, 
do feature extraction and prepare the results ready for publication. 
 



g.Recorder User Manual  5.16.00 5 

Introduction 

Welcome to the g.Recorder. 

g.Recorder is a novel, user-friendly software package for the recording of biosignal data such as EEG, 
ECoG, ECG, EOG, EMG and sensor data. Trigger information and video sequences can also be 
captured. An easy-to-use Replay mode allows for the inspection of data after recording. 

g.Recorder has been designed to work with the g.tec biosignal amplifiers, g.HIamp and g.USBamp, and 
with the portable devices g.MOBIlab+ and g.Nautilus. 

g.Recorder offers raw data inspection and also the extraction and presentation of different parameters. 
These include, but are not limited to, heart rate variability, heart rate, compressed spectral arrays, and 
cerebral function. 

g.Recorder data can be exported seamlessly to g.tec’s biosignal analysis software, g.BSanalyze, for in-
depth offline evaluation and data processing. 
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Intended use 
 
g.Recorder is intended to be used for acquisition, processing, recording and review of biosignal data 
measured by common g.tec biosignal amplifiers. These biosignals may include electroencephalogram 
(EEG), electromyogram (EMG), electrooculogram (EOG), and electrocardiogram (ECG), for example. 
 
The device must not be used for patient monitoring. The device must not be used for the determination of 
brain death. Additional examinations are needed for diagnosis, and no diagnosis may be done only based 
on using this device. 

Indications for use 
 
We have attempted to write this manual as accurately as possible. However, we reserve the right to make 
changes to g.Recorder which may render parts of this manual invalid. We assume no liability as a result 
of the use or application of this product.  
 
No part of this manual may be copied or reproduced without the express permission of the authors. 
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Related Products 

g.tec provides several biosignal analysis elements that are especially relevant to the kinds of tasks you 
perform with g.Recorder and g.tec’s biosignal amplifiers. 

For more detailed information on any of our elements, updates or new extensions please visit our 
homepage www.gtec.at or just send us an email at office@gtec.at. 
 

http://www.gtec.at/
mailto:office@gtec.at
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Related Documents 
 
g.Recorder Quickstart – A short introduction on how to use g.Recorder with g.USBamp, g.HIamp, and 
g.MOBIlab+ devices. 
 
g.Recorder Parallel Port Qickstart – A short introduction on how to use stimulus delivery software 
E-Prime® (Psychology Software Tools, Inc., www.pstnet.com) and Presentation® (Neurobehavioral 
Systems, Inc., www.neurobs.com) over the parallel port with g.HIamp or g.USBamp devices and 
g.Recorder. 
 
g.Recorder Evoked Potentials Quickstart – A short introduction on calculation and display of evoked 
potentials in g.Recorder with g.USBamp devices using g.HIsys for stimulus presentation. 
 
Furthermore, g.tec can provide tutorials on how to load g.Recorder data into EMSE® Suite, BESA®, and 
EEGLAB/ERPLAB Toolbox. 

http://www.pstnet.com/
http://www.neurobs.com/
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Conventions 
 

Item Format Example 

String Variables Courier New Enter filename e.g. MygRecorderSettings.xml 

Menu items Boldface  Select Save from the File menu 
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Release Notes 
 
Release notes bring to your attention new features of, and changes to, g.Recorder when upgrading to a 
newer version. 
 

New features 
• Biosignal amplifier g.Nautilus is now supported. 

Changes 
• Windows 10, 64-bit is now supported; Windows 7 support retired. 

• Updated g.HIamp impedance measurement window and corresponding description according to 
new driver version. 

• The g.HIamp configuration dialog shows an information message now if channel-specific settings 
should be applied but no channels are highlighted. 

• Added performance hint to feature definition section in manual (regarding CFM/CSA). 

• The system requirements have changed. 
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Installation and Configuration 

Hardware and Software Requirements 

g.Recorder requires a PC compatible desktop or notebook workstation running Microsoft® Windows® 

operating system1 and, optionally, a color printer. The table below lists optimal settings (depending on the 
acquisition hardware): 

Hardware Properties 

CPU 2 GHz or faster processor 

Harddisk 30 GB or higher 

RAM 4 GB or higher 

USB 2.0 port One free USB port for the hardlock dongle 

USB 2.0 port (optional) 

One free USB port for each g.HIamp device 
One free USB port for each g.USBamp device 
One free USB port for each g.Nautilus device 
One free USB port for attaching a color printer 

Bluetooth® interface2 (optional)  Bluetooth® interface for g.MOBIlab+ devices 

Screen resolution 1920 x 1080 pixels 

Video camera Webcam 

g.Recorder acquires data from g.tec’s biosignal amplifiers. Depending on the used devices, the 
corresponding drivers for g.HIamp, g.USBamp, g.Nautilus (g.NEEDaccess) or g.MOBIlab+ must be 
installed. Depending on the Windows® operating system, administrator rights might be necessary for the 
installation. 

Software Version 

Microsoft® Windows® 
Windows 10 Pro 
English 
64-bit 

g.HIamp driver 2.16.00 

g.USBamp driver 3.16.00 

g.MOBIlab+ driver 1.16.00 

g.MONcreator 5.16.00 

g.NEEDaccess 1.16.01 

Sentinel HASP® Runtime Environment3 7.50 

Adobe® Acrobat® Reader® 4 DC 2015 

                                                      
1 Microsoft and Windows are either registered trademarks or trademarks of Microsoft Corporation in the United States and/or other 

countries. 
 
2 The Bluetooth® word mark and logos are registered trademarks owned by Bluetooth SIG, Inc. Other trademarks and trade names 

are those of their respective owners. 

 
3 HASP®, Sentinel HASP®, Hardlock®, are registered and/or unregistered trademarks of SafeNet, Inc., or Aladdin Knowledge 

Systems, Ltd., in the United States and other countries. 
 
4 Adobe, Acrobat, and Reader are either registered trademarks or trademarks of Adobe Systems Incorporated in the United States 

and/or other countries. 
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Make sure that your Microsoft® Windows® installation works correctly before installing the g.Recorder 

software. Other software packages except the packages listed above MUST NOT be installed on the 
Windows® PC. During operation of g.Recorder other software as listed above MUST NOT be operated. 
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Installation from a CD 
 
Perform the following steps to install g.Recorder software: 
 

1. Insert the g.tec product CD, open the g.Recorder directory on the CD, open the correct 

directory for the architecture of your PC (Win64) and double-click setup.exe. If User Account 

Control is turned on, additional dialogs may ask for permission. Confirm the dialogs to allow 
installation of g.Recorder through User Account Control. The installation starts and displays the 
welcome message. 
 

 
 

2. Click Next to read the License Agreement. If you agree with the terms, click I Agree and Next. 
 

3. Choose the installation folder (default is C:\Program Files\gtec\) where the install routine 

should copy all necessary files and press Next. 
 

4. Follow the instructions on the screen to install g.Recorder. When the following window informs 
you about completion of installation, click Close to complete. 
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5. After successful installation, insert the hardlock dongle into a free USB port of your PC or 
notebook.  
 
If the computer is connected to the internet, let Windows Update download and install the correct 

driver for the hardlock. For manual installation, run the HASPUserSetup.exe from the 

prerequisites/HASP HL folder on your g.tec CD. 

 
The red light of the hardlock must be on after successful installation. 

 

Uninstall 
 
To remove g.Recorder in Windows 10, use the Programs and Features tool in the Control Panel. 
 
Note that you have to uninstall the hardlock driver software separately if you uninstall the g.Recorder 
software. 
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Files on your Computer 

g.Recorder files - are stored under (it is assumed that the default path setting is used)  
 
 C:\Program Files\gtec\gRecorder 

Example configurations - are stored in the subdirectory  
 
 C:\Program Files\gtec\gRecorder\Config 

Help files - are stored under 
 
 C:\Program Files\gtec\gRecorder\Help 

Tools - import tool to import HDF5 files to MATLAB stored in 
 
 C:\Program Files\gtec\gRecorder\MATLAB Tools 
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Before running g.Recorder 
 
It is recommended to turn off Microsoft Windows’ automatic updates while operating g.Recorder. 
Concurrent Windows updates could interfere with g.Recorder functionality. 
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Running g.Recorder in User Mode 
 
After finishing the installation, g.Recorder can be operated in User Mode with the g.tec biosignal 
amplifiers as described in this chapter. 
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Recorder Main Window 
 
By double clicking on the g.Recorder icon on the desktop g.Recorder is started in User Mode. This 
mode is the standard mode and typically used to acquire data within a specific study using predefined 
configurations. Such configurations can be adapted and created by advanced users in the Administrator 
Mode. 
 
g.Recorder consists of six elements: 
 

- the Status Bar 
- the Toolbar 
- the Data Viewer 
- the Feature Viewer 
- the Video Viewer 
- the Evoked Potentials Viewer 
 

 
In the g.Recorder Menu and Toolbar you can select and set different recording parameters, filenames 
and start/stop the actual measurement, etc. 
 
The Data Viewer window shows the raw biosignal data. Using the menu and toolbar window, the number 
of channels and the seconds on screen can be adapted, etc. The channel information (number and 
name) and the channel scaling is displayed on the left side of the window. 
 
Selected parameters, for example, heart rate and cerebral function are displayed in the Feature Viewer 
window. The parameters are displayed from left to right. On the left side of the window the y-axis scaling 
as well as the specific feature name are displayed. 
 
In the Video Viewer window the actual video sequence is displayed. 
 
The Evoked Potentials viewer displays calculated evoked potentials for each acquired raw data channel, 
if configured. Zooming, scrolling and scaling for the evoked potential plots can be adapted directly in this 
viewer. 
 
The Status Bar indicates the actual state of g.Recorder. 
 
You can resize all windows according to your preferences and needs. Individual windows can be hidden 
to enlarge for example the area of the Feature Viewer. 
 
Note: The actual layout of the screen and the specific settings are stored to a default configuration file 
when g.Recorder is closed. This default configuration is used the next time you start g.Recorder. This 
allows easy continuation of your studies. You can of course load another configuration. 
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Menu 
Toolbar 

Data Viewer 

Feature Viewer 
 
 
Evoked 
Potentials 
 
Video Viewer 
 
Status Bar 
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Status Bar 
 
The actual status of g.Recorder is displayed in the Status Bar at the bottom of the main window. The 
Status Bar shows information that relates to the current recording. The first field shows the current 
g.Recorder Mode. When data are stored to the hard disk the mode is set to Recording. If data is loaded 
for off-line visualization it is set to Replay and otherwise to Standard. 
 

 
 
The next fields display information about the: 

▪ Sampling frequency per channel in Hertz [Hz], 
▪ Total Chan. number, 
▪ selected Filename, 
▪ actual File Size in Megabytes [MB] 
▪ actual System Time in the format hh:mm:ss AM/PM. 
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Toolbar 
 
The Toolbar is always shown below the Menu and includes functions for file opening, printing, starting 
and stopping the data acquisition and video capturing, setting markers and navigating to a certain instant 
in the data. 
 

 
 
 

 

Open… 
Load an already recorded file for offline replay 

 

Print Features… 
Print selected features 

 

Start Data Viewing  
Start displaying data on the screen for visual inspection 
 

➢ Note: No data are stored to disk in this mode 

 

Pause Data Viewing 
Pause displaying data in Standard Mode. If the pause 
button is pressed in Recording mode, then only the raw 
data display in the Data Viewer is stopped. The Video 
Viewer and the Feature Viewer are still updated in real-
time. 
 

➢ Note: All data are still stored to the hard disk if this 
button is pressed in Recording Mode 

 

Record 
Start data acquisition to harddisk. Depending on the 
selected options raw data from the amplifiers, the video 
and features are saved. 
 

➢ Note: For immediate recordings, no specific 
filename or subject information must be provided. 
The filename for the recording will be predefined 
as a standard file name including the date and 
system time. 

 

Stop 
Stop data acquisition 

 
Actual recording time in the format hh:mm:ss from the 
beginning of the recording to hard disk 

 

Zoom Out and Zoom In into the raw data in the Data 
Viewer.  
The percentage can also be inserted directly by typing in 
the desired zooming level 
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Auto Scale 
The data in the Data Viewer are scaled to the actual 
maximal absolute value of the displayed data sequence. If 
Auto Scale is activated, a small icon is displayed in the 
channel information area on the left side of the Data 
Viewer window and the data is rescaled for every new 
page of data. 

 

Global Maximum Auto Scale 
Auto-scale all channels to the global minimum and 
maximum value of the displayed data sequence (plus 
10%). This scaling is applied only once per click. 

 

Individual Maximum Auto Scale 
Auto-scale all the channels individually to their minimum 
and maximum value of the displayed data sequence (plus 
10%). This scaling is applied only once per click. 

 

Offset Auto Scale 
Auto-scale each channel to its individual offset, preserving 
its previously configured amplitude range. This scaling is 
applied only once per click. 

 

Signal Cropping 
Enable or disable signal cropping. If signal cropping is 
enabled, the signal will be cropped at its displayed vertical 
channel range. If signal cropping is disabled, the data of 
the displayed channels may overlap the other channels' 
ranges. Examples are given below. Signal cropping is 
disabled by default. 

 
Set the number of channels and the number of seconds to 
be displayed in the Data Viewer 

 

Off: no video is displayed. 
Display: the video is displayed. 
Record: the video is displayed and recorded (in recording 
mode). 

 

Activate/Deactivate displaying the marker information on 
screen. 

 

Click on the icon to insert a specific marker into the Data 
Viewer and Feature Viewer. 
 

➢ Note: In the Data Viewer the markers are 
presented as vertical color-coded lines from the 
top to the bottom of the window including the 
names of the markers. 

➢ In the Feature Viewer the marker information is 
shown as short color-coded line on top of the 
individual feature. 
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Jump to a specific point in time in Replay mode 

 

Visualization-only Filters 
Customizable digital filters can be applied to the analog 
input channels in the data viewer for visualization purposes 
only. The filters are not applied to the recorded or analyzed 
data.  
To apply filters on recorded and analyzed data, use the 
configuration dialog of the selected amplifier instead. 
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Data Viewer 
 
This window displays the raw data acquired with the g.tec amplifiers. Data are displayed in an overwrite 

mode from left to right. The number of channels displayed on the screen is set via the Toolbar to 1. The 

actual time is given at the top of the first channel.  
 
 

 
 
 

The number on the left side of the green box represents the channel number used on the amplification 
device. This information is useful if more than one biosignal amplifier is used. Here, channel 4 of the first 
amplifier 1 is displayed. The number on the right side of the green box is the logical channel number in 
the actual recording setup. In this case the logical channel number is also 4. 
 
The gray box shows the scaling of the channel. The minimal and maximal input amplitude range 
displayed on the screen is given by the 2 numbers. The horizontal dotted gridline represents 0 µV. The 
minimal and maximal values can be adapted via the menu Settings/Channels. 
 
The light blue box shows the channel name and channel type. The text on the left side gives the chosen 

channel name. Here the selected channel name was FZ. The text on the right side shows the selected 

channel type (e.g. EEG). The channel name and channel type information can be set via the menu 

Settings/Channels. 
 

The zooming level of the Data Viewer as well as the color for the paper, pen and grid can also be defined 
via a context menu by clicking with the right mouse button of a specific channel in the Data Viewer. 
 

 
 

- 189.0 µV 

+ 185.0 µV 

0 µV 
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Feature Viewer 
 
This window displays the parameters extracted from the raw data displayed in the Data Viewer. Data are 
displayed in an overwrite mode from left to right. The features that are computed from the raw data can 
be defined in the menu Analysis/Feature Definition…. In this example the feature CFM (cerebral 
function monitor) is displayed in the upper panel and the feature HR (heart-rate) is displayed in the lower 
panel. 
 
The actual time is given on top of individual feature panels as the time on screen can vary depending on 
the specific user settings. The format of the time is hh:mm:ss. The y-axis scaling and units depend on the 
specific selected feature. The minimal and maximal values can be adapted via the feature specific context 
menu. The y-scaling for the CFM feature is fixed to 0 and 100 µV. The scaling for the HR feature is set to 
0 and 200 beats per minute [bpm]. 
 
 

 
 

Running time  

Name of selected 

feature: CFM [µV] 

Name of selected 

feature: HR [bpm] 
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Context Menu Scaling 
 
The scaling values of the Heart Rate feature can be set via a context menu by clicking on the right mouse 
button in the feature panel. 
 

 
 
 

The Feature Viewer review mode during data acquisition 
 
The Feature Viewer review mode allows for the inspection of previous epochs of feature signals. If the 
time on screen is elapsed, then a menu entry appears in the upper right corner of the Feature Viewer 
window. 
 

 
 
By clicking on the Show previous output a review panel is displayed. 
 

 
 
The Previous Output review panel allows the user to scroll trough past feature signals. The upper panel 
area displays the already recorded features and the lower panel area yields more specific information 
about the time interval Window, the File name of the actual recording and Subject specific information. 
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The content of the panel can be copied to the clipboard for further use by clicking the Copy button, or 
directly printed to the default printer by using the Print button. To close the Previous Output window 
click on Close. 
 
Note: This review panel is only available during data recording. 
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Evoked Potentials Viewer 
 
The Evoked Potentials Viewer displays averaged data frames for each acquired analog input channel. 
An evoked potentials plot is created for each acquired analog input channel. The time frame represents a 
defined time period, consisting of a pre-trigger period, a post-trigger offset and a post trigger period. The 
viewer displays the trigger's occurrence and an averaged time frame for target and non-target evoked 
potentials. Significant differences between target and non-target evoked potentials can be calculated and 
highlighted. 
 
It is possible to configure the scale settings, to scale the data to the individual minimum/maximum of 
each acquired channel or to the global minimum/maximum of all acquired channels. 
 
It is possible to change channel names, signal type, units and sensitivity range in the channel settings 
dialog. Channel names can be loaded from montage files. 
 
By default, all plots are arranged in a square matrix. It is possible to change rows columns and 
arrangement in the arrangement settings. Topographic arrangement of the plots can be loaded from 
montage files. 
 
The color settings allow the user to change the appearance of all elements of the evoked potential plots. 
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Load Configuration 
 
Previously saved configurations can be loaded by clicking on the Load Setup… button in the File menu. 
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The configuration used in this example is for recording one EEG channel and one ECG channel to 
calculate the CFM and Heart Rate features using g.USBamp. 
 

Select the corresponding file CFMECG.xml from  
 

c:\Program Files\gtec\gRecorder\Config 

 
and click Open. 
 
 

 
 
g.Recorder will be initialized with all necessary hardware and software settings. 
 
Previously saved configurations can be loaded by clicking on the Load Setup… button in the File menu. 
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For the recordings in this example, the electrodes are connected to a g.USBamp. 
 

 
 
The picture above displays the front side of the g.USBamp. The front side is divided into four groups 
(A,B,C,D from left to right). Each group consists of four red connectors (1-4, 5-8, 9-12, 13-16) for 
connecting biosignal electrodes (EEG, ECG, EMG, etc.), one blue connector for the reference electrode 
(R) and one yellow connector for the ground electrode (G). 
 
 
For EEG measurements, all electrodes for EEG are connected to Group A (first group on the left side of 
the g.USBamp). One EEG electrode is connected to channel 1 of Group A (red connector), the reference 
electrode to reference R of group A (blue connector) and the ground electrode is connected to ground G 
of group A (yellow connector). 
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For the ECG measurement, all electrodes for ECG are connected to Group B (second group from left). 
One ECG electrode is connected to channel 5 of group B (red connector), the reference electrode to 
reference R of group B (blue connector) and the ground electrode is connected to ground G (yellow 
connector). 
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Recording Information 
 
The Recording dialog opens when the Record button either in the File menu or the task bar is pressed. 
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File 
 
A Path for the data file can be entered or the desired path can be chosen by clicking on the Browse 
button. 
 

The Filename defines the name of the data file. The default filename is RecordSession_ with date and 

time added. When the measurement is started the data and the time are added automatically to the 

filename (e.g. RecordSession_2016.11.09_11.36.02.hdf5). The data is stored in the HDF5 file 

format. For more information about this format see www.hdfgroup.org or refer to the MATLAB help. 
 
The Record Raw Data checkbox toggles whether the raw data from the amplifier is stored to the HDF5 
file or not. For offline processing after measurement it is recommended to record raw data. 
 
Recording Time 
 
IA time limitation for the measurement can be set with the Enable Time Limitation checkbox in the 
Recording Time section. After this time, the measurement is stopped automatically. 

http://www.hdfgroup.org/
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Subject 
 
Information about the subject like Last Name(s), First Names(s) and Date of Birth can be entered in the 
Subject section. Additional information (e.g. medications) can be added in the Comment section. 
 
Session Data 
 
Enter the Session and Run identifier for your recordings. 
 
After finishing these settings click OK. 
 
Note: Mandatory fields (the keyword mandatory is displayed next to this field) must be filled out correctly. 
Otherwise the recording cannot be started. 
 



g.Recorder User Manual  5.16.00 36 

Display Settings 
 
From the Settings menu choose Data Viewer... to change the data representation. 
 

 
 
The Color Settings can be set in the Data Viewer dialog. The Pen color sets the color of the data 
recorded, the Paper color sets the background color and Grid color sets the color of the grid. It is 
possible to change the settings of each channel individually in the Individual color settings group, or for 
multiple channels at once in the Common color settings group. 
 
In the Grid settings area the grid can be enabled and the number of vertical grid lines can be selected.  
 
The normal time scale of the Data Viewer is the elapsed measurement time. If the Show absolute time 
checkbox is checked, then the system time is shown. 
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Channel Settings 
 
A specific number, name, sensitivity and channel type can be assigned to every acquired channel. Click 
onto Channels… in the Settings menu to open the dialog. 
 

 
 
Individual settings 
 
The first column, Device-Ch Nr., shows the device number and also the channel number (e.g. 1-1 for the 
first amplifier and channel 1, 2-1 for the second amplifier and channel 1). The second column, Logical 
Ch. Nr., shows the logical channel number. If two amplifiers with each 16 channels are used then the 
Logical Ch Nr. goes from 1 to 32. 
 
In the Name column a name for the channel can be entered and in the Type column EEG, ECG, EMG, 
EOG, ECoG, Resp., TRIG can be selected. With the channel type selection the Sensitivity of the 
channel is changed automatically.  
 

The Sensitivity and an Offset of each channel can be entered manually. The Unit can be µV, mV or V. 

This Sensitivity affects only the visualization of the raw data.  
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Common Settings 
 
The same settings can be applied to multiple channels at once in the Common settings section. 
 
To only apply a Type to a range of channels, select the Start channel and the End channel and the 
Type in the upper half and click Apply next to it. 
 
To apply a common sensitivity, an offset and a unit to a specific Type of channels, select the lower 
sensitivity (Sens L.), the upper sensitivity (Sens H.), the Offset and the Unit and choose the Type of the 
channels you want to apply those settings on, and click Apply. 
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Video Camera 
 
When a video camera is connected to the PC, the video images can be displayed and recorded with 
g.Recorder. In the menu bar it can be chosen if the video should not be displayed (OFF), just be 
displayed but not recorded (Display) or be displayed and recorded (Record). 
 

 
 
To see the video images in the main window of g.Recorder, select Video Viewer from the View menu. 
 

 
 
The Data Viewer, the Video Viewer and the Feature Viewer can be automatically arranged by selecting 
Arrange in the Window menu. 
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Start and Stop Recording 
 
When all desired settings are done, the measurement can be started. 
 
To display data in the Data Viewer without saving it, click on the View Data button in the Toolbar or 
select Start Data Viewing from the File menu.  
Note: This button is also used to start streaming to SD Card with g.MOBIlab+. 
 

 
 
To record data to the hard disk on your PC, click the Record button or select Record from the File menu. 
 

 
 
To stop data acquisition in Standard mode or pause the data display in the Recording mode, press the 
Pause Data Viewing button or select Pause Data Viewing from the File menu.  
 

 
 
Note: If the button is pressed in Recording mode, only the visualization of the data on the display is 
stopped, but the g.Recorder continues to store data to the HDF5 file. 
 
Click on the Stop button or select Stop from the File menu to stop data acquisition. 
 

 
 
 
g.MOBIlab+ specific functions 
 
The Pause Data Viewing button is the only button activated if a g.MOBIlab+ is streaming to SD Card. 
 

 
 
If g.Recorder is used to reconnect to a streaming g.MOBIlab+, only the Start Data Viewing button is 
activated. 
 

 
 
Note: For g.MOBIlab+, data can either be stored the local hard disk of your PC or streamed to the built-in 
SD card. 
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Markers 
 
Markers can be used during measurement to highlight certain events. g.Recorder allows the user to 
define keyboard markers which (i) indicate an event specific at a certain time point and (ii) region markers 
or toggle markers which can be switched on and switched off to mark a longer lasting event. 
 
Click on Marker Definition under the Analysis menu. 
 

 
 
to open the following window: 
 

 
 
Here, two markers are defined that can be set either by clicking on the marker button in the Toolbar of 

g.Recorder or by pressing the keys on the keyboard. Marker e – Event is a Toggle marker, marker m – 

Movement is a time marker. 
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If e is pressed the signal is marked in the selected marker color until the marker button is pressed again. 

If m is pressed then only the event at a certain time point is marked. 

 
The window below shows the visualization of the markers in the Data Viewer: 
 

 
 
The set markers for the different events are also indicated by small bars near the top of the individual 
features channels in the Feature Viewer: 
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Digital Inputs 
Devices may provide digital inputs that are sampled synchronously with the raw data samples. Digital 
inputs can be acquired and displayed with g.Recorder. A rising or falling edge of an acquired digital input 
is represented as a vertical line including a description consisting of trigger number, value and name. 
 
Some types of devices allow the user to choose if each of those trigger channels should be treated 
individually or if several trigger channels should be combined. 

Individual Triggers 

By default, trigger channels selected for acquisition are treated individually. Depending on their 
configuration, each occurrence of such a trigger channel is represented as a separate event with a value 
of HIGH (H) for rising edges or LOW (L) for falling edges. 
 
 

 

 
 

Combined Triggers 

Combined triggers are supported by g.USBamp and g.HIamp devices only. In this mode, all trigger 
channels of a device are represented by the same event for that device and the value is a binary coded 
decimal made up of the current high or low values of the individual trigger channels. The triggers are 
represented as vertical lines including a description consisting of device's serial number, combined trigger 
tag, event code and name. 
 
This enables reception and interpretation of binary coded trigger values sent via the parallel port. 
g.Recorder supports external stimulation software like Presentation® (Neurobehavioral Systems, Inc., 
www.neurobs.com) and E-Prime® (Psychology Software Tools, Inc., www.pstnet.com) by acquiring event 
codes sent via parallel port. 
 

http://www.neurobs.com/
http://www.pstnet.com/
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Note: E-Prime® and Presentation® are trademarks by their respective owners. 
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Load Electrode Montage 
XML montage files created with g.MONcreator (g.tec medical engineering GmbH, Austria) can be loaded 
to assign predefined names and the topographic arrangement of an electrode cap to the current 
configuration. 
 
Montage files can be loaded by selecting Load Electrode Montage… in the File menu. 
 

 
 
The Data Viewer assigns channel names to the acquired analog channels. The Evoked Potentials 
Viewer, if enabled, arranges the evoked potential plots in a topographic way according to the 2D 
electrode positions in the file. 
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Load, Find, Convert and Replay Recorded Files 

Load, Find and Replay HDF5 files 

 
A recorded data file in HDF5 format can be loaded and reviewed with g.Recorder. 
 
In the File menu select Open...  
 

 
 
Then select the data file you want to load into g.Recorder. The default path of the recorded files is 
 
My Documents/gRecorder 
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Select file RecordSession_2016.11.09_10.10.28.hdf5 and press Open. 
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If you want to find a specific file from the database, please select Find… in the File menu.  
 

 
 
This displays all HDF data files found in your specific working directory. 
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The Search Directory of data files can be set in the Path: field. Use the Browse button to find the 
desired directory. If the Include Subfolders option is enabled, the data files found in the selected path 
including all subdirectories are listed. 
 
Define Datasets enables optionally searching for data sets including Last Name and First Name and if 
selected the Date of Birth of a subject. Results are displayed immediately after typing in the first letter. 
Found Datasets yields information about the search request. 
 
The desired data set can be selected by highlighting the data set. Double clicking or selecting the OK 
button loads the data set for review. Additional short information is given for the data set including the 
Last name, first name, Date of Birth, Recording data, Recording length, Filename and if a video 
information is available. Data sets can be sorted by clicking on one of the row headers e.g. on the Video 
entry. 
 
The entire table can be copied to the clipboard for further use by clicking the Copy Table button. 
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g.Recorder opens the acquired data for off-line visualization. The Data Viewer shows the recorded EEG 
data on channel 1 and the acquired ECG data on channel 2. The Feature Viewer shows the calculated 
CFM and HR features. 
 

 
 
The recorded measurement’s information is displayed in the Status Bar. 
 

 
 
The Mode is Replay, the Sampling frequency is 256 Hz, the number of recorded channels (Total Chan.) 

is 16. The File Name is Record_Session_2016.02.18_10.07.09.hdf and the File Size is 0.413 

megabytes. 
 
You can use the scroll bars on the bottom of a window or the orange vertical position marker in any of the 
g.Recorder windows to move to an arbitrary position in the file.  
 
To review data on-line from the selected position, click on the Start Data Viewing button. 
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Synchronous and asynchronous events are loaded and displayed on the right-hand side of the Data 
Viewer in Replay mode. The navigator on the right-hand side allows the user to jump to a specific event 
by selecting it in the list. The ruler is set to the selected signal's time of occurrence and the current page 
is updated. The event list features the time of occurrence, signal name, signal description, and selected 
color. 
 

 
 
Visualization Filters can be applied to the recorded analog signals in Replay mode. A progress bar is 
displayed for filtering and rendering a large amount of data. 
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To view the file information, select File Info… from the File menu. 
 

  
  
This opens the File Info window yielding information about the data set. To view the file information use 
the Select Section pull down menu (the list contains Raw Data, DeviceInfo, Session Description, 
Subject Description, Marker Description and the recorded features). 
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Select Raw Data to show the settings for each channel: 

 
 

 
 
Click OK to close the dialog. 
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Convert g.MOBIlab+ BIN files to HDF5 format 
 
g.Recorder contains a tool to import g.MOBIlab+ data files stored on the built-in SD Card of g.MOBIlab+. 
Data are converted to the g.Recorder file format HDF5. 
 
In the File menu, click Open… 
 

 
 
In the Files of type section of the Open dialog select g.MOBIlab+ Files (*.BIN) files and browse to the 
folder containing the file to convert. Select the desired file and click Open. 
 
The Save HDF5 File As dialog will open, where the path for the converted HDF5 file can be set. 
 

 
 
Click OK to convert and display the file. 
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Print Recorded Files 
 
The recorded features and the recording information can be printed by selecting Print Features… from 
the File menu. 
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In the Select Features to Print dialog, you can choose the features to be printed. 
 

 
 
Scale 
 
The Scale of the printed feature can either be in cm/h (centimeters per hour) or min/page (minutes per 
page). When selecting the setting 6 cm/h a dataset of 3 hours would need a total space of 18 cm on the 
paper. If the same 3-hour data set is printed with the selection of 60 min/page then 3 pages would be 
printed. 
 
The time scale in the printed document can be set with the checkbox Relative Time Annotation. The 
time is given in absolute format (e.g. 17:05:01) or relative to the measurement time (e.g. 00:05:14). 
  
Select the Print Document Abstract to print the file and subject information. 
 
Feature Selection 
 
Under Feature Selection select the features that should be printed. 
 
Click Next to go to the Print dialog, select a printer and print the file. 



g.Recorder User Manual  5.16.00 57 

Closing the review mode in g.Recorder 
 
To return from Replay mode to Recording mode select the Close button from the File menu. 
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Closing g.Recorder 
 
In the File menu select Exit or click on the cross button in the top right corner of g.Recorder to close the 
application. 
 
Note: If you are in Replay mode you must close the file first with the Close function in the File menu 
before you can exit g.Recorder. 
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g.USBamp Specific Features 

Impedance Measurement with g.USBamp and g.Recorder 

 
The impedance of electrodes connected to a g.USBamp can be measured in g.Recorder. To start this 
tool, click on the Impedance Measurement… button in the Tools menu. 
 

 
 
This opens the dialog shown below. 
 

 
 
Select the channels for impedance checking individually by clicking on the boxes next to the channel 
numbers and click Start. The channel coloring indicates the impedance of the connected electrode. 
Optimal values (e.g. values below 5 kilo-ohm for EEG recordings) are color-code green. 
Acceptable impedance values are in the range of up to 20 kilo-ohm (color code yellow or red). Non-
connected channels or electrodes with impedance values of more than 20 kilo-ohm are color coded blue. 
You can also click on the Select All button to include all electrodes for impedance checking or deselect 
the electrodes pressing the Select None button. 
 
In order to accelerate the impedance check, you can check the Measure above green checkbox. This 
will only check impedances on electrodes with impedance values greater than 5 kilo-ohm. 
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The figure below shows good impedance values for channels 1 and 5.  
 
Note: For EEG measurements the impedance should be below 10 kilo-ohm for optimal recording quality. 
 

 
 
To exit from the Impedance Measurement dialog click on the Close button. 
 
Note: The impedance of electrodes connected to channels 1-16 and the reference channels are 
measured against the ground G of each group. To measure the impedance of all 16 channels and 4 
references against only one ground connect the ground electrode to ground G of group D. 
 

Calibration of g.USBamp with g.Recorder  

 
g.Recorder has a built-in function to calibrate g.USBamps. 
 
Select Calibration… from the Tools menu. 
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This opens the g.USBamp Calibration dialog. Click on the Calibrate Amplifier button to measure the 
offset and the gain of each channel. The actual calibration values are then visualized for each channel.  
 

 
 
 
Press the Apply button to transmit the settings to the g.USBamp and to close the dialog. 
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g.HIamp Specific Features 

Impedance Measurement with g.HIamp and g.Recorder 

 
The impedance of electrodes connected to a g.HIamp can be measured in g.Recorder. To start this tool, 
click on the Impedance Measurement… button in the Tools menu. 
 

 
 
This opens the dialog shown below. 
 

 
 
Select the type of electrode connector boxes that are currently connected to each of the four groups of 
the g.HIamp in the Electrode Types area. Either passive or active electrode connector boxes can be 
used. All groups must use the same type of electrodes even if no box is connected to a specific group. At 
least channel 1 (Group A) and the ground electrode must be connected. 
 
IMPORTANT: If an active electrode box is connected to group A, a special electrode has to be used at 
channel 1. Please see the documentation of the 64-channel active electrode connector box for details on 
impedance measurement. 
 
Select or deselect the channels to use for impedance measurement by clicking on the appropriate 
channel number. Deselected channels get a dark gray background while selected channels have a white 
background. 
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Click Start to start impedance measurement. Impedance measurement is performed periodically for all 
channels at once and lasts a few seconds for each run. 
 
The channel coloring indicates the impedance of the connected electrode. Channels with passive 
electrodes get assigned one of the colors listed in the Passive Electrodes box. Channels with active 
electrodes get assigned one of the colors listed in the Active Electrodes box.  
 
Optimal values e.g. for EEG recordings with passive electrodes should be below 5 kilo-ohm (color-code 
light green). Acceptable impedance values are in the range of up to 20 kilo-ohm (color code light yellow or 
light blue). Bad impedance values above 20 kilo-ohm are color coded light red. Channels whose 
impedance couldn’t be measured properly are color coded black. 
 
Optimal values e.g. for EEG recordings with active electrodes should be below 30 kilo-ohm (color code 
green). Acceptable impedance values are in the range of up to 100 kilo-ohm (color code yellow or blue). 
Bad impedance values above 100 kilo-ohm are color coded red. Channels whose impedance couldn’t be 
measured properly are color coded black. 
 
Channel 1 and the ground electrode are used as the reference for impedance measurement of all other 
channels. No impedance can be measured for those channels. Hence, channel 1 is always grayed and 
no impedance value will be assigned. However, if the reference signal measured on channel 1 is not valid 
(which might occur when the skin contact is too poor, or when no electrode is connected on that channel, 
or when artifacts mess up the measured signal on that channel), no impedance value can be calculated 
and color code black will be assigned to all other channels. 
 
Otherwise, if the reference signal measured on a specific channel is not valid (which might occur when 
the skin contact is too poor, or when no electrode is connected on that channel, or when artifacts mess up 
the measured signal on that channel), no impedance value can be calculated and color code black will be 
assigned to that specific channel. 
 
Click Stop to stop impedance measurement (even if impedance measurement has aborted with a 
connection error, for example if the device was disconnected during measurement) and close the dialog 
by clicking Close. 
 
If Acoustic feedback is checked, a short beep is produced on the PC speaker when the impedance of 
any of the electrodes changes from red to any better impedance value. The better the impedance value 
the electrode changes to, the higher the frequency of the beep. If the impedance of any electrode 
changes to red, a long beep sounds. To turn off acoustic feedback, uncheck the Acoustic feedback 
checkbox. 
 
Check Show channel names if the names of the channels should be displayed instead of their numbers. 
This only works for channels that got a name assigned before in the Channel Settings dialog. Nothing 
additional is displayed for channels that got no name assigned that way. 

Calibration of g.HIamp with g.Recorder 

 
g.Recorder has a built-in function to calibrate a g.HIamp device. Select Calibration… from the Tools 
menu. 
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This opens the g.HIamp calibration dialog. To calculate new calibration values for the device, ensure that 
the calibration set is applied onto the amplifier at first. See the manual of the calibration set for detailed 
instructions on how to do this. Then click the Calibrate Amplifier button to measure offset and gain of 
each channel. Confirm the following dialog reminding you to apply the calibration set by clicking OK. 
 
Calculation of new calibration values lasts about 10 seconds. A dialog will inform you after calculation has 
been completed. The actual calibration values are then visualized for each channel, but not applied yet.  
 
If at least one channel could not be calibrate due to broken channels or a broken calibration set, for 
example, a dialog will inform you about the involved channels and their calibration value entries are 
displayed as NaN (“not a number”). 
 
To restore the initial factory calibration values, click Restore Factory Settings. 
 

 
 
Press the Apply button to transmit the newly calculated or restored factory calibration values to the 
g.HIamp and apply them on the device. Press the Restore button to restore the old values on the 
amplifier. To edit the calibration values manually, double-click the desired cell and enter your value for 
scaling and offset (the settings will actually be transmitted and applied after the Apply button is pressed). 
 
For channels that received NaN values as calibration result, 1.0 will be set for scaling and 0.0 for offset on 
pressing the Apply button. 
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g.Nautilus Specific Features 

Impedance Measurement with g.Nautilus and g.Recorder 

 
The impedance of electrodes connected to a g.HIamp can be measured in g.Recorder. To start this tool, 
click on the Impedance Measurement… button in the Tools menu.  
 

 
 
This opens the dialog shown below. 
 

 
 
Select or deselect the channels to use for impedance measurement by clicking on the appropriate 
channel number. Deselected channels have a dark gray background, while selected channels have a 
white background. 
 
Click Start to start impedance measurement. Impedance measurement is performed periodically for all 
channels simultaneously, and lasts a few seconds for each run. 
 
The channel coloring indicates the impedance of the connected electrode. The color code for the 
impedance measurement is listed in the Active Electrodes box.  
 
Optimal values e.g. for EEG recordings with active electrodes should be below 30 kilo-ohm (color code 
green). Acceptable impedance values are in the range of up to 100 kilo-ohm (color code yellow or blue). 



g.Recorder User Manual  5.16.00 66 

Bad impedance values above 100 kilo-ohm are color coded red. Channels whose impedance couldn’t be 
measured properly are color coded black. 
 
The Cz electrode and the ground electrode are used as the reference for impedance measurement of all 
other channels. If the reference signal measured on channel Cz is not valid (which might occur when the 
skin contact is too poor, or when no electrode is connected on that channel, or when artifacts affect the 
measured signal on that channel), no impedance value can be calculated and color code black will be 
assigned to all other channels. 
 
Otherwise, if the reference signal measured on a specific channel is not valid (which might occur when 
the skin contact is too poor, or when no electrode is connected on that channel, or when artifacts affect 
the measured signal on that channel), no impedance value can be calculated and color code black will be 
assigned to that specific channel. 
 
Click Stop to stop impedance measurement (even if impedance measurement has aborted with a 
connection error, for example if the device was disconnected during measurement) and close the dialog 
by clicking Close. 
 
If Acoustic feedback is checked, the PC speaker presents a short beep when the impedance of any of 
the electrodes changes from red to any better impedance value. The greater the improvement in the 
impedance value, the higher the frequency of the beep. If the impedance of any electrode changes to red, 
a long beep sounds. To turn off acoustic feedback, uncheck the Acoustic feedback checkbox. 
 
Check Show channel names if the names of the channels should be displayed instead of their numbers. 
This only works for channels that got a name assigned before in the Channel Settings dialog. Nothing 
additional is displayed for channels that got no name assigned that way. 
 
Check Show impedance values in kΩ to display the measured impedance in kilo-ohm. If the measured 
impedance value is very low, LOW is displayed instead of a value in kilo-ohm. If the impedance value is 
very high, HIGH is displayed instead of a value in kilo-ohm. 
 

Calibration of g.Nautilus with g.Recorder 
g.Recorder has a built-in function to calibrate a g.Nautilus device. Select Calibration… from the Tools 
menu. 
 

 
 
This opens the g.Nautilus calibration dialog. Click the Calibrate Amplifier button to measure offset and 
gain of each channel. Confirm the following dialog reminding you to apply the calibration set by clicking 
OK. 
 
A dialog will inform you after calculation has been completed. The actual calibration values are then 
visualized for each channel, but not applied yet. 
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Running g.Recorder in Administrator Mode 
 
The Administrator Mode allows the user to configure a g.HIamp, g.USBamp, g.MOBIlab or g.Nautilus 
amplifier and add and configure the different feature extraction methods of g.Recorder. 
 

➢ Note: This mode requires an administrator password for the software. 
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Activate Administrator Mode 
 
To change from User Mode into the Administrator Mode click on Administrator Mode under the Mode 
menu. 
 

 
 
 

Note: Per default no Administrator Password is set. 
 
 
To activate the Administrator mode just click OK in the Administrator Authentication dialog. If a 
password is set, enter the password and click OK. 
 

  
 
To change the password, click on Change Password and enter the Old Password. Then, press the 
Enter key and enter the New Password, then enter the password again in the Retype new Password 
field and click OK. 
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Select and Configure Hardware 

g.HIamp 
In the Settings menu, select Select Hardware… 
 

 
 
The Select Hardware dialog opens: 
 

 
 
Select the desired g.HIamp device that should be used for measurement from Available Hardware and 
click on the arrow button. This g.HIamp and its serial number are displayed in the Selected Hardware 
box. 
 
Click OK to finish hardware selection. 
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To configure the selected g.HIamp device, click on g.HIamp… in the Settings menu. 
 

 
 
The configuration dialog opens with the amplifier’s serial number (here e.g. HA-2016.02.01): 
 

 
 
 
 
 
 
 



g.Recorder User Manual  5.16.00 72 

AMPLIFIER SETTINGS 

Sample Rate [Hz] specify the sampling frequency of the g.HIamp in Hz. 

Common Reference specify one of the device’s channels as the common reference channel. This 
is a quick way to set the selected channel as a bipolar channel for all other 
channels of the device. Existing settings for bipolar channels will be 
overwritten. 

 

OPTIONS 

Master set the amplifier to master mode. 

Enable Trigger indicates if the digital trigger input line is acquired as well. This checkbox will 
be enabled automatically if at least one trigger line is selected to acquire (see 
the digital IN settings section for further details). If this checkbox gets disabled 
by the user, the trigger input line will not be acquired. 

Enable Counter a sample counter is applied on the first acquired channel, which overruns at 
1000000. 

Enable Hold enable/disable the signal hold function. 

 

TEST MODE 

Activate Test Signal enable/disable the internal test signal generator, which generates a test signal 
using the specified settings on the GND (ground) connector. 

Wave Shape specify the wave shape of the test signal. 

Frequency [Hz] specify the frequency of the test signal. 

Amplitude [µV] specify the amplitude of the test signal in microvolts. 

Offset [µV] specify the offset of the test signal in microvolts. 

 

CHANNEL SETTINGS 

Bipolar perform a bipolar derivation between 2 input channels. 

Bandpass perform a digital bandpass filtering of the input channels. 

Notch perform a bandstop filtering to suppress the power line frequency of 50 Hz or 

60 Hz. 

 
Perform the following steps to configure the highlighted channels: 
 

1. Highlight the channels in the list box that should be edited. Use the Ctrl key or the Shift key to 
highlight multiple channels. To select all channels, use Ctrl+A. To highlight all channels of one 
group, click the group header. Highlighted channels are represented with an orange background 
color, as illustrated for channel 3. 
 

2. Check or uncheck the checkbox of one of the selected channels in the Acquire column to include 
the highlighted channels in data acquisition or exclude them. 
 

3. If no common reference has been set before, or you want to change the reference/bipolar 
channel for a specific channel, select the desired bipolar channel from the Bipolar list and press 
the corresponding Apply to highlighted button right below. 
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4. Select a bandpass filter from the Bandpass list and press the corresponding Apply to 
highlighted button right below. 
 

5. Select a notch filter from the Notch list and press the corresponding Apply to highlighted button 
right below. 

 
If no channel is highlighted when one of the Apply to highlighted buttons is clicked, the system instead 
informs the user of this error and the settings do not change. 
 
Click OK to finish the configuration of the g.HIamp and apply it to the device. 
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Digital IN for g.HIamp 
 
In the Settings menu, click on g.HIamp Digital IN… to open the configuration dialog for the digital I/O 
settings. 
 

 
 
The Trigger inputs are sampled synchronously with the analog input channels. 
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Check the box of the desired channels, enter a Description, select a color by clicking on the Color 
button (Color Sel.), and define the edge (Edge Detection).  
 
Confirm the settings and close the dialog with OK. 
 
If the event occurs, a marker is generated and visualized with the biosignal data. 
 
If Combined Triggers are selected, all individual trigger channels are enabled and the individual channel 
selection becomes disabled. Combined triggers are always configured to detect rising edges. It is 
possible to change the Color and Description for combined triggers. The displayed marker name and 
color for a combined trigger are always the same. The marker's value will be the binary coded decimal 
made up of the current HIGH and LOW values of all individual trigger channels with trigger channel 1 as 
least significant bit and trigger channel 16 as most significant bit. 
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g.USBamp version 2.0 and version 3.0 
 
In the Settings menu, select Select Hardware… 
 

 
 
The Select Hardware dialog opens: 
 

 
 
From Available Hardware, select the g.USBamp device that should be used for the measurements and 
click on the arrow button, as shown in the figure above. This g.USBamp with the serial number is now 
displayed in the Selected Hardware box. Repeat these steps If multiple g.USBamps are connected to 
the PC. 
 
Click OK to finish hardware selection. 
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To configure the g.USBamp, click on g.USBamp… in the Settings menu. 
 

 
 
The configuration window opens with the amplifier serial number (here e.g. UA-2007.10.15): 
 

 
 
 
AMPLIFIER SETTINGS 
 
Common Ground 
 

check the ground that should be connected to common ground 

Common Reference 
 

check the reference that should be connected to common reference 

Channel Selection 
 

check the analog input channels that should be acquired 

Sampling Rate [Hz] 
 

specify the sampling frequency of the g.USBamp in Hz 

  
  
 
Options 
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Master 
 

set the amplifier to master mode if multiple units are used 

Shortcut 
 

enable the shortcut input 

 
Mode 
 

 

Measure 
 

amplify the inputs and send the data to the PC 

Counter A counter is applied to channel 16 
  
Test Signal apply internal test signal to all inputs 

NOTE: The test signal works for sampling rates equal or below 600 Hz 
 

Analog Output 
 

generate a Sine-, Square-, Sawtooth- or Noise-signal as test signal 

Amplitude 
 

specify the amplitude of the test signal (max: 244 mV) 

Offset 
 

specify the offset of the test signal 

Frequency 
 

specify the frequency of the test signal 

 
CHANNEL SETTINGS 
 
Bipolar 
 

perform a bipolar derivation between 2 input channels 

Bandpass 
 

perform a digital bandpass filtering of the input channels 

Notch perform a bandstop filtering to suppress the power line frequency of 50 Hz or 
60 Hz 
 

Perform the following steps to configure the selected channels: 

1. Highlight the channels in the listbox that should be edited. Use the Ctrl key or the Shift key to 
highlight multiple input channels.  
 

2. Select the Bandpass filter HP: 0.5 / LP: 30 and press the Apply button to assign the bandpass to 
the highlighted channel(s). The selection is shown in the listbox. 
 

3. Select the 50 Hz Notch filter to suppress the power line interference at 50 Hz and then press the 
Apply button 
 

4. To perform a bipolar derivation between channels 1 and 2, select the first channel in the listbox. 
Then select channel 2 under Bipolar and press the Apply button. The settings appear in the 
listbox. This configuration subtracts channel 2 from channel 1 and the bipolar derivation will be 
visible on channel 1. 
 
NOTE: Select 0 under Bipolar and assign it to the channel if no bipolar derivation should be 
performed 

Finish the configuration of the g.USBamp by clicking the OK button. 
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Digital IO for g.USBamp version 2.0 

 
The serial number for a g.USBamp 2.0 starts with UA-xxxx.xx.xx 
 
g.USBamp 2.0 has 3 digital inputs and 2 digital outputs. In the Settings menu click on g.USBamp Digital 
IO… to open the dialog. 
 

 
 
The Trigger input is sampled together with the analog input channels and therefore gives a synchronous 
response. The inputs and outputs D1, D2, D3 and D4 are sampled asynchronously. 
 

 
 
Check the box of the desired channels, enter a Description, select a color (Color Sel.) and define the 
edge (Edge Detection). 
 
Then close the dialog with OK. 
 
If the event occurs, a marker is generated and visualized with the biosignal data. 
 
If Combined Triggers are selected, all individual trigger channels are enabled and the individual channel 
selection becomes disabled. Combined triggers are always configured to detect rising edges. It is 
possible to change the Color and Description for combined triggers. The displayed marker name and 
color for a combined trigger are always the same. The marker's value will be the binary coded decimal 
made up of the current HIGH and LOW values of all individual trigger channels with trigger channel 1 as 
the only bit in that value. 
 
NOTE: The Trigger input must be used if very accurate timing is needed. 
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Digital IO for g.USBamp version 3.0 
 
The serial number for a g.USBamp 3.0 starts with UB-xxxx.xx.xx 
 
g.USBamp 3.0 has 8 digital inputs and 4 digital outputs. In the Settings menu, click on g.USBamp 
Digital IO… to open the dialog. 
 

 
 
The trigger inputs Trigger 1 to Trigger 8 are sampled synchronously with the analog input channels. The 
outputs Out 1 to Out 4 are sampled asynchronously. 
 



g.Recorder User Manual  5.16.00 81 

 
 
Check the box of the desired channels, enter a Description, select a color (Color Sel.) and define the 
edge (Edge Detection). 
 
Then close the dialog with OK. 
 
If the corresponding trigger event occurs, a marker is generated and visualized along with the biosignal 
data. 
 
If Combined Triggers are selected, all individual trigger channels are enabled and the individual channel 
selection becomes disabled. Combined triggers are always configured to detect rising edges. It is 
possible to change the Color and Description for combined triggers. The displayed marker name and 
color for a combined trigger are always the same. The marker's value will be the binary coded decimal 
made up of the current HIGH and LOW values of all individual trigger channels with trigger channel 1 as 
least significant bit and trigger channel 8 as most significant bit. 
 
NOTE: A very accurate timing is obtained for all input channels. 
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g.MOBIlab+ 
 
In the Settings menu select Select Hardware… 
 

 
 
The Select Hardware dialog opens: 
 

 
 
From Available Hardware, select the g.MOBIlab+ that should be used for the measurements and click 
on the arrow button as shown in the figure above. Now this g.MOBIlab+ with the serial number and the 
COM port number is displayed in the Selected Hardware box. The COM port of your g.MOBIlab+ can be 
found in Bluetooth Devices in the Control Panel. 
  
Click OK to finish hardware selection. 
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To configure g.MOBIlab+ click on the g.MOBIlab+… button in the Settings menu. 
 

 
 
The configuration window opens: 
 

 
 
Info 
 
In this section, the COM port where g.MOBIlab+ is connected and the serial number of g.MOBIlab+ are 
shown. 
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Analog Channels 
 
The channels to be recorded can be selected in the Analog Channels section. The Sensitivity, the 
highpass HP, the lowpass LP and the Polarity are displayed. Additionally a 50 or 60 Hz Notch filter can 
be applied. 
 
Sampling Frequency 
 

The Sampling Frequency is 256 Hz. 

 
SD card 
 
If a SD Card is inserted into g.MOBIlab+, then the SD card status is displayed in the SD Card section 
including the space left on the SD Card. 
 
Operation Mode 
 
The checkboxes Generate test signal and Enable streaming are located in the Operation Mode 
section on the bottom of the dialog. 
 
With the Generate test signal checkbox selected, g.MOBIlab+ will output a test signal consisting of 
ramps with different slopes on the eight analog channels and the digital channels will toggle at different 
rates. This function is implemented to test the connection between g.MOBIlab+ and PC or laptop. It is 
recommended that the markers are turned off for this function. 
 
The Enable streaming to SD card checkbox is only enabled if a SD Card is inserted into g.MOBIlab+. If 
the checkbox is selected then it is possible to disconnect g.MOBIlab+ from the g.Recorder environment 
and the device will continue to stream data to the built-in SD Card. If a connected g.MOBIlab+ is already 
streaming data then this Status is also displayed in the Operation Mode section. 
 
g.MOBIlab+ provides eight digital channels. To configure the digital inputs and outputs click on the 
g.MOBIlab+ Digital IO… button in the Settings menu.  
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DIO1 to DIO4 can be configured as digital inputs or outputs. DI1 to DI4 are digital inputs. Set the Edge 
Detection to either detect only Falling or Rising edges or to detect both, Rising+Falling. 
 

 
 
Perform the settings as shown in the figure above and close the dialog with OK. Then the following 
controls will be visible in g.Recorder:  
 

 
 
Click on the buttons to set the markers. All markers are stored together with the biosignal data. The digital 
inputs and outputs are sampled together with the biosignal data. 
 
If Enable streaming in the g.MOBIlab+ dialog is selected and the data acquisition is started by clicking 
on the Display button the g.MOBIlab+ Start Streaming to SD Card dialog will appear. 
If g.MOBIlab+ is already streaming, the Status in the Device section will be set to Streaming. The SD 
Card section will be disabled. 
 

 
 
The Start Streaming to SD Card dialog asks the user to provide a Filename for the data recorded to the 
SD card. 
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The default filename is SESSION, characters entered are set to uppercase automatically. Characters not 

allowed for a filename are <, >, \, /, :, *, |, ? and ”. Numbers can also be used. 
 
The Space left on SD Card in MB is also displayed 
 
To confirm streaming to SD card click Yes. Then data are displayed in g.Recorder for control purposes 
and data are streamed to the built-in SD card on g.MOBIlab+ 
Click No to simply display data in g.Recorder. 
 
When the data acquisition is stopped, then g.MOBIlab+ Stop Streaming To SD card dialog will appear. 
To stop the data transfer to the PC and data acquisition to the SD Card in g.MOBIlab+ click Yes. To 
continue streaming data to the SD Card click No. 
 

 
 
If g.MOBIlab+ is already streaming data to the SD card, then you can reconnect the device to 
g.Recorder. An information dialog will appear. Click OK to display data again from g.MOBIlab+ in 
g.Recorder. 
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g.Nautilus 
 
In the Settings menu, select Select Hardware… 
 

 
 
The Select Hardware dialog opens: 
 

 
 
Select the g.Nautilus that should be used for the measurements from Available Hardware and click on 
the arrow button as shown in the figure above. Now this g.Nautilus with the serial is displayed in the 
Selected Hardware box. 
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If the g.NEEDaccess Server is not running, g.Nautilus devices cannot be used. An error message will be 
shown. The installation and GDS service status should be checked, if this error message appears. 
  
Click OK to finish hardware selection. 
 
To configure the g.Nautilus, select g.Nautilus… from the Settings menu. 
 

 
 
The configuration window opens with the amplifier serial number: 
 

 
 
AMPLIFIER SETTINGS 

Input Source specify the input source for data acquisition. 

Electrode: record EEG data 
Shortcut: record with shortcut of inputs 
Testsignal: enables the internal test signal generator, which generates a 
square wave test signal on each channel. 

Sample Rate specify the sampling frequency in Hz. 
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Network Channel Set the network channel used for data transmission. 

Noise Reduction enable noise reduction using DRL (driven-right leg) algorithm of activated 
channels. 

CAR enable common average reference of activated channels (see column CAR). 

Acceleration Data if enabled, the measured acceleration in x, y, and z directions in the range of 
± 6 g come as three additional channels after the analog channels. 

Counter if enabled, a sample counter comes as an additional channel after the 
acceleration data channels. 

Link Quality if enabled, wireless link quality in percent comes as an additional channel after 
the counter channel. 

Battery Level if enabled, battery level (state of charge) in percent comes as an additional 
channel after the link quality channel. 

Digital Inputs indicates if the digital trigger input line is acquired as well. This checkbox will 
be enabled automatically if at least one trigger channel is selected to be 
acquired (see the digital IN settings section for further details). Setting or 
clearing this checkbox by the user has no effect. 

if enabled, the digital input channels come encoded in a single additional 
channel after the battery level channel. 

Validation Indicator if enabled, the validation indicator indicating successful wireless transmission 
of a sample (1 for valid, 0 for invalid) comes as an additional channel after the 
digital inputs channel. 

 

Channel SETTINGS 

Sensitivity set channel sensitivity of analog input channels. 

Bipolar perform a bipolar derivation between 2 input channels. 

Bandpass perform a digital bandpass filtering of the input channels. 

Notch perform a bandstop filtering to suppress the power line frequency of 50 Hz or 
60 Hz. 

CAR select channels for common average reference calculation (CAR checkbox 
must be enabled to active the filter). 

Noise Reduction select the channels that should be used for calculating the DRL signal for 
noise reduction (Noise reduction checkbox must be enabled to active the DRL 
function). 

 
Perform the following steps to configure the highlighted channels: 
 

1. Highlight the channels in the list box that should be edited. Use the Ctrl key or the Shift key to 
highlight multiple channels. To select all channels, use Ctrl+A. To highlight all channels of one 
group, click the group header. Highlighted channels are represented with an orange background 
color, as illustrated for channel 3. 
 

2. Check or uncheck the checkbox of one of the selected channels in the Acquire column to include 
the highlighted channels in data acquisition or exclude them. 
 

3. If you want to change the reference/bipolar channel for a specific channel, select the desired 
bipolar channel from the Bipolar list and press the corresponding Apply to highlighted button 
right below. 
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4. Select a bandpass filter from the Bandpass list and press the corresponding Apply to 
highlighted button right below. 
 

5. Select a notch filter from the Notch list and press the corresponding Apply to highlighted button 
right below. 
 

6. If the CAR checkbox is checked and you want to include the highlighted channels in CAR 
calculation, select Yes from the CAR list and press the corresponding Apply to highlighted 
button right below. 
 

7. If the Noise reduction checkbox is enabled and you want to consider the highlighted channels 
for noise reduction, select Yes from the Use for Noise Reduction list and press the 
corresponding Apply to highlighted button right below. 

 
If no channel is highlighted when one of the Apply to highlighted buttons is clicked, the system instead 
informs the user of this error and the settings do not change. 
 
Click OK to finish the configuration of the g.HIamp and apply it to the device. 
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Digital IN for g.Nautilus 
The serial number for a g.Nautilus starts with NB-xxxx.xx.xx 
 
g.Nautilus has 8 digital inputs. In the Settings menu, click on g.Nautilus Digital IN… to open the dialog. 
 

 
 
The trigger inputs Trigger 1 to Trigger 8 are sampled synchronously with the analog input channels. 
 

 
 
Check the box of the desired channels, enter a Description, select a color (Color Sel.) and define the 
edge (Edge Detection). 
 
Then close the dialog with OK. 
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If the corresponding trigger event occurs, a marker is generated and visualized along with the biosignal 
data. 
 
If Combined Triggers are selected, all individual trigger channels are enabled and the individual channel 
selection becomes disabled. Combined triggers are always configured to detect rising edges. It is 
possible to change the Color and Description for combined triggers. The displayed marker name and 
color for a combined trigger are always the same. The marker's value will be the binary coded decimal 
made up of the current HIGH and LOW values of all individual trigger channels with trigger channel 1 as 
least significant bit and trigger channel 8 as most significant bit. 
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DAQ Simulator 
 
In the Settings menu, select Select Hardware… 
 

 
 
The Select Hardware dialog opens: 
 

 
 
Select Serial Number 1 from the Available Hardware list and click on the arrow button to add it to the 
Selected Hardware list. If more than 16 channels should be simulated, add as many DAQ Simulators as 
needed. 
 
Click OK to close the dialog. 
 
To configure the DAQ Simulator, select DAQ Simulator from the Settings… menu. 
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The configuration window opens with the simulator serial number (e.g. 1): 
 

 
 
Sampling Rate [Hz] specify the sampling frequency of the DAQ Simulator in Hz 

 
Signal Frequency [Hz] 
 

specify the frequency of the test signal 

Amplitude [µV] 
 

specify the amplitude of the test signal 

Time Interval [ms] set the interval between the imports of the samples. (e.g. set the Timer 
Interval to 50 ms at a sampling rate of 1 kHz then every 50 ms 50 samples 
are drawn) 
 

DC Offset [µV] 
 

specify the offset of the test signal 

Channel Selection select the channels to be recorded  
 

 
If multiple simulators are configured use the Apply to all Amplifiers button to perform the settings for all 
amplifiers. 
 
Note: data in the DAQ Simulator is not sampled equidistantly! 
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Feature Definition 
 
g.Recorder allows the user to calculate in real-time specific features which are shown in the Feature 
Viewer. g.Recorder supports the Cerebral Function Monitor (CFM) parameter, the Heart Rate (HR) and 
the Compressed Spectral Array (CSA).  
 
Warning: High sampling rates, many channels or extensive feature calculation can overload the PC's 
hardware resources, resulting in data loss. This might occur immediately or even after some time after 
starting acquisition. Please plan feature calculation meaningfully and carefully.  
 
Select Feature Definition… from the Analysis menu 
 

 
 

In the Feature Definition dialog select the Cerebral Function Monitor (CFM)  
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Then select the EEG Channel that is used to calculate the feature and add the feature with the arrow 
button. 
 

 
 
The channel number and the selected feature are displayed on the right side. 
 

Calculate the HR from the ECG channel 5 and the CSA also from EEG channel 1. 
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Configure CFM 
 
To configure the CFM feature select it and click on the Advanced button. This opens the CFM 
Configuration dialog below. 
 

 
 
Filter Band  
 
Lowest Frequency [Hz] – select the lower cutoff frequency for the CFM calculation 
Highest Frequency [Hz] – select the upper cutoff frequency for the CFM calculation 
 
Classification 
 
Classify CFM Pattern – check to automatically classify the CFM signal 
Percentile [%] – the percentile specifies the lower and upper signal amplitude border for the 
segmentation 
Epoch Duration [min] – specify the segment size in minutes 
Pattern Definition – specify the segmentation rules 
 
Display 
 
Time on Screen [min] – enter the minutes shown on one page in the Feature Viewer 
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Press on the Pattern Definition… button to open the following dialog: 
 

 
 
Then enter a Name, the Lower level, the Upper level and define a Color for the specific pattern. 
 
Click the Add button to add the pattern to the list. With Remove, a selected pattern can be removed from 
the list. With the Apply changes button, the settings for a selected pattern in the list can be applied. 
 
The figure above shows the standard classification used for neonatal recordings. 
 
Close the dialog with the OK button. 
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Configure Heart Rate 
 

Select the HR feature and click on the Advanced button to open the following dialog: 

 

 
 
QRS Complex Classification 
 
Base HR [bpm] - base heart rate in beats per minute 
Maximum HR [bpm] - maximum heart rate in beats per minute 
Minimum HR [bpm] - minimum heart rate in beats per minute 
Maximum RR Increase [%] - maximum allowed increase of interval between two QRS complexes in 
percent 
Maximum RR Decrease [%] - maximum allowed decrease of interval between two QRS complexes 
 
General  
 
Calculation Interval [min] – specify the interval that is used to calculate the HR 
Time on Screen [min] - enter the minutes shown on one page in the Feature Viewer 
Show Digital Display – if selected, the actual information for heart rate or heart rate variability is 
displayed right next to the feature channel. 
 
Output  
 
Calculate Mean HR [bpm] – mean HR of Calculation Interval 
Calculate Standard Deviation of HR [%] – standard deviation of HR in Calculation Interval 
Calculate RMSSD [ms] - root mean square of successive differences of HR in the Calculation Interval 
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Configure CSA 
 

Select the CSA feature and click on the Advanced button to open the following dialog: 

 

 
 
Calculation 
 
NFFT - number of samples for the FFT 
Overlap - number of samples that overlap 
Start Frequency - lower value of y-axis scaling in Hz  
End Frequency - higher value of y-axis in Hz 
Blockoverlap - number of samples that overlap with preceding epoch 
Epoch Duration - duration between calculated FFT outputs 
Amplitude Min [µV] – minimal amplitude coded in the colormap  
Amplitude Max [µV] – maximal amplitude coded in the colormap 
Number of Colors – number of color used for the CSA colormap 
 
Display  
Time on Screen [min] - enter the minutes shown on one page in the Feature Viewer 
 
Click the Colormap… button in the Calculation section to define the colormap used for the CSA. This 
opens the following dialog: 
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The CSA is plotted in µV2/Hz ranging from Amplitude Min to Amplitude Max. In the example below, the 
different colors in the color bar represent the power of the signal recorded with a logarithmic scale ranging 
from 0.006 to 25.000 µV2/Hz with 256 colors. 
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Marker Definition 
 
Markers can be used during measurement to highlight certain events. g.Recorder allows the user to 
define markers which indicate a specific time point, and region markers which indicate a time window.  
 
Click on Marker Definition under the Analysis menu. 
 

 
 
to open the following window: 
 

 
 

Define one marker with the key m and name Movement, select the green color. Do not check the Toggle 

checkbox to have a marker that indicates a specific point in time. Use the Add button to define the 
marker. 
 

Then define key e as a region marker by checking the Toggle checkbox. Set the description to Event. 

 
Finally, close the window. 
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Evoked Potentials Definition 
The Evoked Potentials Configuration dialog allows the user to configure the calculation of evoked 
potentials. 
 
Click on Evoked Potentials at the Analysis menu. 
 

 
 

 
 
Filtering: 

• Bandpass filter – contains a list of previous defined filters to preprocess incoming raw data. The 
filter is applied before the data is framed by the occurrence of a trigger. The filter is only applied 
for EP calculation, not to recorded or displayed raw data in the Data Viewer. 

 
Trigger Channels: 

• Enable/disable calculation of evoked potentials for target and/or non-target EPs. 

• Select a trigger source from the list of acquired digital inputs or defined keyboard markers. In the 
example above, keyboard marker a (Keyboard) is selected as the trigger for calculation of target 
EPs and keyboard marker s (Keyboard) is selected as the trigger for calculation of non-target 
EPs. 
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• If a combined trigger is used, define the Value that triggers calculation of the corresponding class 
of evoked potentials. 

• If only one class of evoked potentials (e.g. target EPs) is selected and has a trigger assigned, the 
Separate target and non-target evoked potentials by odd and even trial numbers option can 
be used to assign each second occurrence of the same trigger to the other class of evoked 
potentials (non-target EPs) automatically. 

 
Baseline Correction: 

• Enable/Disable Correct baseline of frames before averaging to either remove or allow offsets 
for evoked potential calculations. If enabled, the offset of the pre-trigger period is removed from 
the whole frame for each channel and each trial individually. 

 
Averaging: 

• Select Average all frames to average up each triggered frame of the same class as long as the 
session lasts. Select Average a limited number of most recent frames only to only include the 
selected number of most recently triggered frames of the corresponding class in the averaged 
result. 

 
Significance: 

• Calculate significance – Enable/Disable highlighting of statistical significant differences between 
the target and non-target evoked potential classes. This option will only be available if two 
classes of evoked potentials are calculated. 

• The Significance level is the maximum acceptable probability of error for significance calculation 
in percent. 

• Select the number of Minimum frames required for calculation and display of significance. 

 
Trigger Timing: 

• Set the Pre-Trigger period duration to define the acquired time before the trigger occurrence. 

• Set the Post-Trigger period offset to define the gap to leave blank after the trigger occurrence. 
This can be useful to suppress artifacts that accompany the stimulus (e.g. audio trigger artifacts) 
in display only. The Post-trigger period offset gap is not excluded from calculation. 

• Set the Post-Trigger Period duration to define the acquired time after Post-Trigger period 
offset. 
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Save Configuration 
 
To store the settings select Save Setup as… function in the File menu. 
 

 
 
The last configuration is loaded automatically at the next program start. 
 

Load Configuration from the command line 
 
g.Recorder can be initialized by previous stored configurations using the command line option  
grecorder \d [Configuration file]. 
 
If the configuration file cannot be found at startup, then the last used configuration will be loaded. This 
option is useful for providing specific study setups. 
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